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Chapter 1

1 Quick Start 



1.1 Hardware System Diagram 
APAX-5072 coupler with APAX-5000 I/O modules will be controlled by a Ethernet/IP
master. Here, we use Allen-Bradley CompactLogix PLC as example. The complete
system includes APAX series, CompactLogix PLC and a PC used to configure the
setting of CompactLogix PLC. The system hardware architecture can be shown as
figure below. 

1.2 Installing the ADAM/APAX .NET utility
Advantech provides the ADAM/APAX .NET utility which allows developers and end
users to see APAX-5072 and connected I/O modules, perform configurations, and
simple testing of the I/O. This software can be helpful when checking wiring inputs
prior to installing the runtime project. It is also able to detect and test other Advantech
supported hardware for this product such as Ethernet or Serial I/O. (ADAM-4000,
ADAM-5000 and ADAM-6000 series). Therefore, you need to install ADAM/APAX
.NET utility first to configure APAX-5072 and related APAX-5000 I/O modules. After
that, you can use other software package which supports Ethernet/IP protocol (such
as Allen-Bradley RSlogix) to perform write or read action to APAX-5072. 
The installation file is contained in the CD. When you launch the CD, select the APAX
Software button and click the ADAM/APAX .NET Utility button to find the installation
file. Besides, you always can link to the web site http://www.advantech.com and click
into the Download area under the Support site to get the latest version of the ADAM/
APAX .NET utility.

Note! 1. Do not use hub between the Ethernet/IP master and APAX-5072. 
Only Ethernet switch is acceptable. 
2. The quality of the network will influence the Ethernet/IP communica-
tion performance, so make the network as simple as possible. 
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1.3 Configuring APAX-5072 with ADAM/APAX .NET
Launch ADAM/APAX .NET utility by selecting Start >> All Programs >> Advantech
Automation >> AdamApax .NET Utility >> AdamApax .NET Utility. On the left
side of the utility window, you can see several items showing IP address under the
Ethernet item. (These items represent the Ethernet port on your computer). Click on
the item showing the IP address which stands for the specific port used to connect
with APAX-5072 module, and then click the icon Search Modules on the toolbar. (Or
you can right click the item and select Search option.) Then you should be able to
see APAX-5072 item showing under the IP address item, as shown below.

Click the item showing the APAX-5072 (with APAX-5072 IP address). Type the cor-
rect password on the pop-up window. All the connected APAX-5000 I/O modules will
show under the APAX-5072 item. (In this example, they are APAX-5017, APAX-5028
and APAX-5040 and APAX-5046)

Note! Before you start search the APAX-5072 module in utility, remember to 
change that APAX-5072 module's mode to Utility mode. Refer to APAX-
5072 Hardware Manual for how to configure APAX-5072 mode. 
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On the right window, you can perform all related configurations toward APAX-5072
through the three tabs: Information, Setting and EDS file export. Refer to the figure
below. You can upgrade related firmware to selected APAX-5072 coupler on the
Information tab. Click the I/O modules items under the APAX-5072 item, then you
can configure or read/write specific I/O modules. Take the figure below as example,
you can read the AI channel value or perform related setting after you click the APAX-
5017 item. Refer to Appendix A for more detail for these configurations.
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1.4 Configure & Access Data in EtherNet/IP Master
Here, we use an Allen-Bradley CompactLogix 1769-L32E PLC to connect with APAX-
5072 and related APAX-5000 I/O modules. So we need to use Allen-Bradley RxLogix
software to configure the connection between CompactLogix PLC and APAX-5072.
First, Select the New item on the File menu to create a new RxLogix project after you
launch the RxLogix software, as shown by figure below.

We want to add APAX-5072 connection into this new RxLogix project. So, right click
the Ethernet item on the left tree window under I/O configuration>>1769-L32E Eth-
ernetPortLocalENB and select New Module to create a new connection. (The path
may be changed depending on the AB PLC you used)
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Then a pop-up window appears. Click the Communication check box on the by Cat-
egory tab. 

Select the ETHERNET-MODULE item and click the OK button. 
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Then you can configure the connection name by type into the Name text box. And
configure IP address of APAX-5072 by the IP Address. Then type the correct Con-
nection parameters including Input Assembly Interface, Input Size, Output
Assembly Interface, Output Size, Configuration Assembly Interface, and Con-
figuration Size. Refer to Appendix B for how to configure it. Click OK button when
you have done the configuration. 

Enter the desired polling time between AB PLC with APAX-5072 module in the
Request Packet Interval (RPI) combo box as shown by figure below. Click the OK
button when you have done the configuration. 
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After you have completed these settings, select the Download item to download
these setting to the connected Allen-Bradley CompactLogix 1769-L32E PLC. 

Click the Download button. 
APAX-5072 Software Manual 8



C
hapter 1

Q
uick S

tart
Click the Yes button when a pop-up window shows "Done downloading. Change con-
troller mode back to Remote Run?" Then you should be able to see APAX-5000 input
modules' data and perform write action to APAX-5000 output modules. Refer to
Appendix B for APAX-5000 I/O modules' data mapping. 

1.5 Using L5K File to Access APAX I/O
In previous section, you have learned how to manually define the Ethernet/IP
address in Allen-Bradley RxLogix software, and then you can access APAX-5000 I/O
modules’ data. Actually, there is an easier way to do the address mapping configura-
tion. Advantech offered APAX/ADAM utility can export current APAX-5000 I/O mod-
ules configuration as L5K file that Allen-Bradley RxLogix software can import it. So
you don’t need to do the address mapping by yourself. Below is the procedure. 

First, Select the New item on the File menu to create a new RxLogix project after you
launch the RxLogix software, as shown by figure below.
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Select the suitable Allen-Bradley controller (In this example, it is 1769-L32E) in the
Type combo box. Name the controller by typing into the Name text box (In this exam-
ple, it is DEMO_100421) and click the OK button.

Now, we want to save current project into one .L5K format file. Select the Save as
item on the File menu as figure below, and save the L5K in specific location in your
computer. (In this example, the file is saved as “DEMO_100421.L5K” file.) Remem-
ber to choose RSLogix 5000 Import/Export File (*.L5K) in the Save as type combo
box.
APAX-5072 Software Manual 10
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Launch ADAM/APAX .NET utility by selecting Start >> All Programs >> Advantech
Automation >> AdamApax .NET Utility >> AdamApax .NET Utility. On the left
side of the utility window, you can see several items showing IP address under the
Ethernet item. (These items represent the Ethernet port on your computer). Click on
the item showing the IP address which stands for the specific port used to connect
with APAX-5072 module, and then click the icon Search Modules on the toolbar. (Or
you can right click the item and select Search option.) Then you should be able to
see APAX-5072 item and connected APAX-5000 I/o modules showing under the IP
address item, and select the L5K tab on the right side of the utility window as shown
below. 
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Click the Export button at the right-down corner to generate a new L5K file which can
represent current APAX-5000 I/O configurations. A pop-up window as figure below
will appear. Open the previous L5K file (In this example, it’s DEMO_100421.L5K) you
have generated from RxLogix software file and APAX/ADAM Utility will generate a
new L5K file based on it within the APAX-5000 I/O modules’ configuration. Select the
previous generated file (In this example, it’s DEMO_100421.L5K) in the dialog and
click the Open button. 

A pop-up message will appear showing the new L5K file export has been done suc-
cessfully. Click the Ok button to finish it. 
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You can browse the new generated L5K file. In this example, it is
DEMO_100421AB.L5K.

Since the new L5K file is available, launch Allen-Bradley RxLogix software again.
Select the Open item on the File menu. 
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Select the new generated L5K file (In this example, it’s DEMO_100421AB.L5K), and
click Open button. Another pop-up window will appear. Save a new .ACD file by typ-
ing your desired file name and click the Import button. Then all related configurations
have been done.  You can see it by the Module Properties and Controller tag win-
dow as shown by figures below:
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Chapter 2

2 Analog I/O Board 
Settings



2.1 Analog I/O Board Settings
Range Settings for Analog I/O Boards. These ranges are provided for reference. Not
all boards support all ranges. Please see hardware manual for valid ranges for a par-
ticular board.

Setting Type Value (Hex)
Millivolts DC
(mV)

+/- 15mV 0x0100
+/- 50mV 0x0101
+/- 100mV 0x0102
+/- 150mV 0x0103
+/- 500mV 0x0104
0~150mV 0x0105
0~500mV 0x0106

Volts DC 
(V)

+/- 1V 0x0140
+/- 2.5V 0x0141
+/- 5V 0x0142
+/- 10V 0x0143
+/- 15V 0x0144
0~1V 0x0145
0~2.5V 0x0146
0~5V 0x0147
0~10V 0x0148
0~15V 0x0149

Milliamps (mA) 4~20mA 0x0180
+/-20mA 0x0181
0~20mA 0x0182

Counter settings Pulse/DIR 0x01C0
Up/Down 0x01C1
Up 0x01C2
Frequency 0x01C3
AB 1X 0x01C4
AB 2X 0x01C5
AB 4X 0x01C6

Pt-100 (3851) Pt-100 (3851) -200~850 'C 0x0200
Pt-100 (3851) -120~130 'C 0x0201
Pt-100 (3851) -200~200 'C 0x0202
Pt-100 (3851) -100~100 'C 0x0203
Pt-100 (3851) -50~150 'C 0x0204
Pt-100 (3851) 0~100 'C 0x0205
Pt-100 (3851) 0~200 'C 0x0206
Pt-100 (3851) 0~400 'C 0x0207
Pt-100 (3851) 0~600 'C 0x0208

Pt-200 (3851) Pt-200 (3851) -200~850 'C 0x0220
Pt-200 (3851) -120~130 'C 0x0221

Pt-500 (3851) Pt-500 (3851) -200~850 'C 0x0240
Pt-500 (3851) -120~130 'C 0x0241
APAX-5072 Software Manual 18
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Pt-1000 (3851) Pt-1000 (3851) -200~850 'C 0x0260
Pt-1000 (3851) -120~130 'C 0x0261
Pt-1000 (3851) -40~160 'C 0x0262

Pt-100 (3916) Pt-100 (3916) -200~850 'C 0x0280
Pt-100 (3916) -120~130 'C 0x0281
Pt-100 (3916) -200~200 'C 0x0282
Pt-100 (3916) -100~100 'C 0x0283
Pt-100 (3916) -50~150 'C 0x0284
Pt-100 (3916) 0~100 'C 0x0285
Pt-100 (3916) 0~200 'C 0x0286
Pt-100 (3916) 0~400 'C 0x0287
Pt-100 (3916) 0~600 'C 0x0288

Pt-200 (3916) Pt-200 (3916) -200~850 'C 0x02A0
Pt-200 (3916) -120~130 'C 0x02A1

Pt-500 (3916) Pt-500 (3916) -200~850 'C 0x02C0
Pt-500 (3916) -120~130 'C 0x02C1

Pt-1000 (3916) Pt-1000 (3916) -200~850 'C 0x02E0
Pt-1000 (3916) -120~130 'C 0x02E1
Pt-1000 (3916) -40~160 'C 0x02E2

Balco 500 Balcon(500) -30~120 0x0300
Ni 518 Ni(518) -80~100 'C 0x0320

Ni(518) 0~100 'C 0x0321
Ni 508 Ni(508) 0~100 'C 0x0340

Ni(508) -50~200 'C 0x0341
Thermistor 3K Thermistor 3K 0~100 'C 0x0360
Thermistor 10K Thermistor 10K 0~100 'C 0x0380

Thermistor 10K -50~100 'C 0x0381
T/C TypeJ T/C TypeJ 0~760 'C 0x0400

T/C TypeJ -200~1200 'C 0x0401
T/C TypeK T/C TypeK 0~1370 'C 0x0420

T/C TypeK -270~1372 'C 0x0421
T/C TypeT T/C TypeT -100~400 'C 0x0440

T/C TypeT -270~400 'C 0x0441
T/C TypeE T/C TypeE 0~1000 'C 0x0460

T/C TypeE -270~1000 'C 0x0461
T/C TypeR T/C TypeR 500~1750 'C 0x0480

T/C TypeR 0~1768 0x0481
T/C TypeS T/C TypeS 500~1750 'C 0x04A0

T/C TypeS 0~1768 'C 0x04A1
T/C TypeB T/C TypeB 500~1800 'C 0x04C0

T/C TypeB 300~1820 'C 0x04C1
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Appendix A

A ADAM/APAX .NET 
Utility Operation



A.1 ADAM/APAX .NET Utility General Window
After you install the ADAM/APAX .NET utility, you can launch it by selecting Start >>
All Programs >> Advantech Automation >> AdamApax .NET Utility >> AdamA-
pax .NET Utility. Refer to Section 1.2 for installation information.

After you launch the utility, you should see the operation window as figure below.
Except APAX-5000 I/O modules, other devices such as ADAM-4000, ADAM-5000
and ADAM-6000 modules can also be searched and configured in this utility.

The operation window consists of four areas --- the Menu, the Toolbar, the Module
Tree Display Area and the Status Display Area. 
APAX-5072 Software Manual 22
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A.1.1 Menu
The menu at the top of the operation window contains:

The File menu 
1. Open Favorite Group - You can configure your favorite group and save the 

configuration into one file. Using this option, you can load your configuration file 
for favorite group.

2. Save Favorite Group - You can configure your favorite group and save the con-
figuration into one file. Using this option, you can save your favorite group into 
one configuration file.

3. Auto-Initial Group - If you want to have the same favorite group configuration 
when you exit ADAM/APAX .NET utility and launch it again, you need to check 
this option.

4. Exit - Exit ADAM/APAX .NET Utility.

The Tools menu
1. Search - Search if there are any remote I/O modules connected. For I/O mod-

ules communicated by serial (such as ADAM-4000 modules), click the COM1 
item (COM 2 is an internal COM port) under Serial item in the Module Tree Dis-
play Area first before you click this button. For I/O modules communicated by 
Ethernet (such as APAX-5072 with APAX-5000 I/O modules, ADAM-6000 mod-
ules), click the Ethernet item in the Module Tree Display Area first before you 
click this button.

2. Add Devices to Group - You can add any I/O modules to your favorite group by 
this option. You need to select the device you want to add in the Module Tree 
Display Area (it will be described below) first, and then select this option to add.

3. Terminal for Command Testing - ADAM modules support ASCII commands 
and Modbus as communication protocol. You can launch the terminal to com-
municate with remote module by these two kinds of protocols directly. Refer to 
ADAM-4000, ADAM-5000 and ADAM-6000 manual for ASCII and Modbus com-
mand.

4. DiagAnywhere Searcher - "DiagAnywhere" tool, an abbreviation of "Diagnostic 
Anywhere", is a networking solution for remotely monitoring and controlling 
other Windows based devices. It is very similar to a remote desktop application 
with some additional features. This option will show all devices with DiagAny-
where server in the same network. Click the Search button to start the search. 
The device with DiagAnywhere server will be listed, as shown by figure below.
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5. Print Screen - You can acquire current utility window image and save it as an 
image file (*.bmp).

6. Monitor Stream/Adam5000 Event Data - This functionality is for ADAM/APAX 
module which supports Data Stream/Event function. If you enable Data Stream 
functions and configure this computer (where the utility is installed)  as the host 
to receive data, then you can use this option to receive and view the data. 

7. Monitor Peer-to-Peer (Event Trigger) - ADAM-6000 modules support Peer-to-
Peer function. You can use this option to see data transferred from connected 
ADAM-6000 module which is enabled Peer-to-Peer function. Refer to ADAM-
6000 manual for more detail.

8. Monitor GCL IO Data Message - ADAM-6000 modules support GCL function. 
You can use this option to see data transferred from connected ADAM-6000 
module which is enabled GCL function. Refer to ADAM-6000 manual for more 
detail.

The Setup menu
1. Favorite Group - You can configure your favorite group including add one new 

device (only for remote device), modify or delete one current device, sort current 
devices and diagnose connection to one device.

2. Refresh COM and LAN node - ADAM/APAX .NET utility will refresh the serial 
and LAN network connection situation.

3. Add COM Port Tree Nodes - This option is used to add serial COM ports in 
APAX/ADAM.NET Utility.

4. ShowTreeView - Check this option to display the Module Tree Display Area.
5. Enable Calibration Function - Check this option to let APAX-5000 analog 

module able to perform calibration procedure. 

The Help menu 
1. Check Up-to-Date on the Web - Choose this option, it will automatically con-

nect to Advantech download website. You can download the latest utility there.
2. About ADAM/APAX .NET Utility - Choose this option, you can see version of 

ADAM/APAX .NET Utility installed on your computer.

A.1.2 Toolbar
The eight buttons on toolbar represent the eight common used items from the Menu.
Refer to figure below for the definition of each button:

A.1.3 Module Tree Display Area
ADAM/APAX .NET Utility is one complete software tool that all APAX and ADAM I/O
module can be configure and operated in this utility. The Module Tree Display Area
is on the left part of the utility operation window. There are four categories in the
Module Tree Display Area:
APAX-5072 Software Manual 24
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Serial
All serial remote I/O Modules connected to the host computer will be listed in this cat-
egory. You also can configure COM port parameter (such as baud rate, parity, stop
bit) here. 

Ethernet
All Ethernet remote I/O modules (including APAX-5072 modules) connected to the
host computer will be listed in this category. 

ADAM-4500/5510 Series
All ADAM-4500 and ADAM-5000 controllers connected to the host computer through
serial interface in the same system, such as ADAM-5510 or ADAM-4501, will be
listed in this category. Simply click this item all related modules will be displayed
automatically.

Favorite Group
You can define which devices listed in Serial or Ethernet categories above into your
personal favorite group. This will make you easier to find your interested modules.
Click on the ADAM device item under Favorite group item, and select Favorite >>
New in Setup menu to create a new group. After you create your own group, click on
your group and select Favorite >> New in Setup menu to add any remote devices
into your group. You can also select Diagnose connection to check the communica-
tion. 

A.1.4 Status Display Area
Status Display Area, on the right part of utility operation window, is the main screen
for operation. When you select different items in Modules Tree Display Area, Status
Display Area will change dependently. You can do all configurations and tests on this
area. 

A.2 General Configuration
If you click the APAX-5072 item in the Module Tree Display Area, the Status Dis-
play Area should looks as figure below. There will be three configuration tabs shown
on the Status Display Area: Information, Setting,  and EDS file export.
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A.2.1 Information

Refer to figure above. You can download related firmware to selected APAX-5072 by
clicking the Download button in the Firmware and Kernel area. You also can name
the selected APAX-5072 module by the Name and Description text box in the Device
area. All I/O modules connected with APAX-5072 module with its ID number are
listed in the Description tab (the left tab). You can see all I/O modules supported by
APAX-5072 by the Support Modules tab.

A.2.2 Setting
Here, you can change related networking setting, including IP address, Subnet Mask,
Default Gateway, and Host Idle Timeout. After you have complete the setting, click
the Apply button to apply the setting.  Remember these parameters will be used
when you configure the network setting on the Ethernet/IP master such as RxLogix
used to configure Allen-Bradley CompactLogix PLC.

A.2.3 EDS File Export
EDS file is used to save Ethernet/IP I/O modules' information, and you can leverage
it for the data access. You can generate the EDS file on the EDS file export tab, by
clicking the Export button to generate a L5K file based on current APAX-5000 I/O
APAX-5072 Software Manual 26
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configuration. Refer to figure below. Then you can import that EDS file in the Ether-
net/IP master software (such as Allen-Bradley RxLogix). 

A.3 I/O Module Configuration
When you click any I/O module in the Module Tree Display Area, the Status Dis-
play Area at the right side will automatically change to show the module's informa-
tion. There will be two tabs displayed: Module Information and I/O Information.
(Refer to the figure below)

On the Module Information tab, module information (such as module name, switch
ID, module description, and firmware version) is displayed. You also can update
related firmware to the specific module by the Download button. 
On the I/O Information tab, you can write or read all channels' status and perform
related configuration and calibration. Refer to sections below for more detail. 
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All APAX-5000 I/O modules support Locate function. Using this function, you can
easily identify specific APAX modules through utility. Click the Locate button in the
upper right corner of the Status Display Area, and the text on the button will become
"Disable". Refer to figure below. It means you have enabled Locate function, and the
power LED of that selected module will continuously flashing, letting you easily to
identify. Click the Locate button again to disable the Locate function (the text on the
button will become "Enable"), and that module's LED will stop flashing. 

A.3.1 Analog Input Modules

There are two parts for the I/O Informaion tab of APAX-5000 AI module. At the bot-
tom is the Channel Information Area. You can see all channels' type, Modbus
address, value, channel status (burnout or not), and range. Above the Channel
Information Area is the Setting Panel Area. If you don't want see the Setting Panel
Area, you can click the Hide Setting Panel check box to hide the Setting Panel
Area. If you want to see the raw data (presented in Hexadecimal format) from the
input channels, click the Show Raw Data check box. 
If you want to configure specific input channels' range or integration time, select the
channels in the Channel Information Area (use the "Shift" or "Ctrl" key on keyboard
to select multiple channels at the same time). Choose appropriate range and integra-
tion  time for the selected channels by the Range and Integration Time combo
boxes in the Setting Panel Area and then click the Apply button to save the configu-
ration. If you want to save the same range setting for all channels, click the ApplyAll
check box before you click the Apply button. 

You can define specific channels reading or not by the Enable and Disable buttons.
Refer to figure below, channel 2 ~ 6 are disabled that no data will be read.

Note!  In order to remove the noise from the power supply, APAX AI modules 
feature built-in filter. Filters are used to remove noise generated from 
environment. The integration time is used to configure the filter fre-
quency. 
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Most APAX-5000 analog module supports auto calibration. To perform calibration,
you need to enable calibration function by Setup menu (Setup>>Enable Calibration
Function). After that, you can perform auto calibration to the AI modules by clicking
the Auto button in the Calibration Area. The module will automatically calibrate
itself. You don’t need to connect any external devices or instruments. 

APAX-5000 AI modules offer data logging functionality. Click the Trend Log button to
launch Trend Log window. Here, you can configure which channels you want to log
by the check box representing specific channels in the Draw Setting Area. Click the
color box beside the channel index to configure the color of the trend line on the plot.
You can set the data log period (how often APAX-5000 modules record its channel
value) by the PollingInterval combo box. Refer to figure below. Here, only channel 0
~ channel 4 value are logged, and the data log period is 200 milliseconds.
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Click the Start Record to start data logging. At first, a pop-up window will appear to
let you configure where you want to save the log file. Then, the data logging will start
and the data will be displayed on the plot.
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APAX-5000 AI modules support Burnout function. It means when there is no signal
wiring, the input channel will detect it. Below are the modules which supports Burnout
function:

1. APAX-5013: Burnout function available for RTD input (all type)
2. APAX-5017: Burnout function only available for current input (only 4 ~ 20 mA)
3. APAX-5017H: Burnout function available only for current input (only 4 ~ 20 mA)
4. APAX-5018: Burnout function available for thermocouple input (all type) and 

current input (only 4 ~ 20 mA)

Refer to figure below. Now we configure all input channels' range as 4 ~ 20 mA for
APAX-5017 module. Only channel 1 has real current signal input, so you can see
other channels' status showing "Burnout". (Only channel 1 status shows "Good",
means there is signal input.) 

You can choose to show the maximum value or minimum value of the input range as
the read value when burnout condition happens (no wire input signal). It is configured
by the Range combo box in the Burnout Value Area. Refer to figure above. The set-
ting is "Up scale", meaning the maximum value of the input range will be shown when
burnout condition happens. So you can see all other channels' values (except chan-
nel 1) are 20. (meaning 20 mA, the maximum value of the input range)

Now, if we select "Down scale" for the Range combo box in the Burnout Value Area,
it means the minimum value of the input range will be shown when burnout condition
happens. Refer to figure below. You can see all other channels' values (except chan-
nel 1) are 4. (meaning 4 mA, the minimum value of the input range) 
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A.3.2 Analog Output Module 

There are two parts for the I/O Information tab of APAX-5000 AO module. At the bot-
tom is the Channel Information Area. You can see all channels' type, Modbus
address, value, range, startup value (the initial value when the AO module is power-
on) and safety value (the default value when the communication is broken). Above
the Channel Information Area is the Setting Panel Area. If you don't want see the
Setting Panel Area, you can click the Hide Setting Panel check box to hide the Set-
ting Panel Area. If you want to see the raw data (presented in Hexadecimal format)
from the output channels, click the Show Raw Data check box.
If you want to configure specific output channels' range, select the channels in the
Channel Information Area. Choose appropriate range by the Range combo box in
the Setting Panel Area and then click the Apply button to save the configuration. If
you want to save the same range setting for all channels, click the ApplyAll check
box before you click the Apply button. 

If you want to change specific output channel' output value, select that channel by
clicking the channel in the Channel Information Area or choosing it from Channel
combo box in the Setting Panel Area. Then define the output value by the Value text
box or the horizontal slide below in the Setting Panel Area. Then, click the Apply
Output button to save the configuration. You can see the channel output value
changed in the Channel  Information Area. Similarly, you can save the value in the
Value text box to become the startup value by the Set as Startup button. And you
also can see the startup value changed in the Channel Information Area.

APAX-5000 output module like AO or DO module supports Fail Safety Value (FSV)
function. When the output module lose its ability to communicate with controller or
coupler, all output channels will become the pre-defined value (the safety value). You
can enable the FSV function by clicking the Enable check box in the Safety Func-
tion area. 

Note! Startup value means the default value when the module boots. 
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Then, click the Set Value button to configure the safety value.  A pop-up window will
appear, like the figure below. You can simply type the desired safety value for each
channel. In this example, safety value of channel 0 is configured as 10 mA, while
other channels' are 0 mA. Click the Apply button after you have complete your set-
ting. You can see the modified safety value showing by the Safety Value column in
the Channel Information Area.

APAX AO module like APAX-5028 offer manual calibration functionality. To perform
calibration, you need to enable calibration function first by Setup menu
(Setup>>Enable Calibration Function). After the calibration functionality is
enabled, you can click the Trim to Span button and Trim to Zero button, and then
you can perform span calibration and zero calibration, separately. When you click the
Trim to Zero button, you will see a dialog popping-up as figure below. The specific
channel will generate output signal using the minimum value within range which is
shown in the Calibration Value text box. Connect that channel to an external accu-
rate instrument and measure the output signal. Using the Counts to trim buttons to
adjust until the output value real matches the value in the Calibration Value text box.
Then click the Apply button to save the calibration configuration. 

Note! You also can set the safety value by entering the value to the Value text 
box or drawing the horizontal slide below in the Setting Panel Area. 
Then click the Set as Safety button to apply that value as safety value.  

Note! The zero calibration can only be implemented when the AO range is 
±10V, ±5V or 0 ~ 20 mA
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When you click the Trim to Span button, you will see a dialog popping-up as figure
below. The specific channel will generate output signal using the maximum value
within range which is shown in the Calibration Value text box. Connect that channel
to an external accurate instrument and measure the output signal. Using the Counts
to trim buttons to adjust until the output value real matches the value in the Calibra-
tion Value text box. Then click the Apply button to save the calibration configuration. 

Note! The S\span calibration can only be implemented when the AO range is 
±10V, ±5V or 0 ~ 20 mA
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A.3.3 Digital Input Module 

There are two parts for the I/O Information tab of APAX-5000 DI module. At the bot-
tom is the Channel Information Area. You can see all channels' type, Modbus
addres, value, and mode. Above the Channel Information Area is the Setting Panel
Area. If you don't want see the Setting Panel Area, you can click the Hide Setting
Panel check box to hide the Setting Panel Area. 
APAX DI module supports digital filter functionality. Signals with period less the filter
width will be filtered (regarding as high frequency noise). You can configure the filter
width (acceptable pulse width). Select the channels you want to configure in the
Channel Information Area (use the "Shift" or "Ctrl" key on keyboard to select multiple
channels at the same time). Type the appropriate value (unit: 0.1 ms) into the Mini-
mum low signal width text box to configure acceptable minimum pulse width in the
Setting Panel Area. After you complete the configuration, click the Apply button to
save the configuration. 

Note! APAX-5040 is equipped with a filter which minimum period is 3 ms. 
Therefore, the minimum value for the Minimum low signal width text 
box is 30. 
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A.3.4 Digital Output Module 

There are two parts for the I/O Information tab of APAX-5000 DO module. At the
bottom is the Channel Information Area. You can see all channels' type, Modbus
address, value, mode and safety value (the default value when the communication is
broken). Above the Channel Information Area is the Setting Panel Area. If you
don't want see the Setting Panel Area, you can click the Hide Setting Panel check
box to hide the Setting Panel Area. 
If you want to change specific output channels' output value, select those channels
by clicking the channel in the Channel Information Area (use the "Shift" or "Ctrl" key
on keyboard to select multiple channels at the same time). Then define the output
value by the Set True button or Set False button in the Setting Panel Area. Then,
click the Apply button to save the configuration. You can see the channel output
value changed in the Channel Information Area. 

APAX-5000 output module like AO or DO module supports Fail Safety Value (FSV)
function. When the output module lose its ability to communicate with controller or
coupler, all output channels will become the pre-defined value (the safety value). You
can enable the FSV function by clicking the Enable check box in the Safety Func-
tion Area. 

Then, click the Set Value button to configure the safety value.  A pop-up window will
appear, like the figure below. You can simply type the desired safety value for each
channel. In this example, safety value of channel 3 to 8 are "True", while other chan-
nels' safety value are "False". Click the Apply button after you complete your set-
tings. (You can set all channels' safety value together by clicking the check box inside
the Safety State cell.) You can see the modified safety value showing by the Safety
Value column in the Channel Information Area.
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A.3.5 Counter Module
Usually, except counter input channels, there are also digital input and digital output
channels for counter module like APAX-5080. So there will three I/O Information tabs
(DI, DO and CNT) 

(A) DI tab for digital input channels
Refer to figure below. It is similar to standard DI module's I/O Information tab (Refer
to Section A.3.3). At the bottom is the Channel Information Area. You can see all
channels' type, Modbus address, value, and mode.

Note! For APAX-5080, there is no digital filter for digital input channels. So you 
can not configure the minimum accept signal width like DI module. 
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(B) DO tab for digital output channels
The DO tab for counter module looks very similar to the DO module's I/O Information
tab (Refer to Section A.3.4). At the bottom is the Channel Information Area. You can
see all channels' type, Modbus address, value, and alarm situation. Above the Chan-
nel Information Area is the Setting Panel Area. If you don't want see the Setting
Panel Area, you can click the Hide Setting Panel check box to hide the Setting
Panel area.

You can configure each DO channel as simple digital output channel (it can be con-
trolled manually) or an alarm channel (channel status will depend on value from a
specific counter channel) on the Setting Panel Area. Select the channels you want
to configure in the Channel Information Area (use the "Shift" or "Ctrl" key on key-
board to select multiple channels at the same time). You can set these channels'
mode by clicking DO or Alarm radio button. Then click Apply button to save the con-
figuration. If you want to save the same mode setting for all channels, click the
ApplyAll check box before you click the Apply button.
When you select DO mode for specific channels, you can manually control these
channels' value. Refer to figure below. Select the channels you want to control the
output value in the Channel Information Area (use the "Shift" or "Ctrl" key on key-
board to select multiple channels at the same time). Then define the output value by
the Set True button or Set False button at the lower left of the Setting Panel Area.
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When you select Alarm mode for specific channels, those channels' value will be
changed automatically based on the mapping counter input channel's value. In other
words, the DO channel becomes alarm channel for specific counter channel. Below
are some related parameters you need to set for alarm: 

1. Mapping Channel combo box: It defines which counter channel's value is used 
for this alarm channel (DO channel).

2. Limit value text box: The reference value to decide when an alarm happens. 
When the specific channel counter value is higher or lower than this limit value 
(depends on the Alarm Type combo box), alarm will be activated. 

3. Alarm Type combo box: 
"High": When the counter value is higher than the reference limit value (defined 
by the Limit value text box), the alarm will be activated. 
"Low": When the counter value is lower than the reference limit value (defined 
by the Limit value text box), the alarm will be activated.

4. DO behavior combo box: What action that DO channel will perform when alarm 
is activated. 
"High Level": DO channel will become logic high level when alarm happens.
"Low Level": DO channel will become logic low level when alarm happens.
"High Pulse": A high pulse will be generated when alarm happens.
"Low Pulse": A low pulse will be generated when alarm happens.

5. DO pulse width (ms) text box: When you select "High Pulse" or "Low Pulse" for 
DO behavior, this parameter define the generated pulse width. (Unit: ms)

After you have complete the setting, click the Apply button to save the configuration.
If you want to save the same mode setting for all channels, click the ApplyAll check
box before you click the Apply button. 

Refer to figure below. DO channel 1 is configured as alarm channel for counter input
channel 7 (defined by the Mapping channel combo box). So as long as the counted
value of the counter input channel 7 is greater (defined by the Alarm Type combo
box) than 50 (defined by the Limit value combo box), then the alarm is activated,
and the value of DO channel 1 will become logic low level (defined by the DO behav-
ior combo box).
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Once alarm is activated, the alarm status will be latched. It won't change its value to
previous status even when alarm condition is gone. You need to manually clear the
alarm to make it back to the normal status, by click the Clear alarm latch button in
the Alarm Area on the Setting Panel Area. 

(C) CNT tab for counter input channels
At the bottom is the Channel Information Area. You can see all channels' type, Mod-
bus address, value, mode, startup value, counter status, and counter gate setting sit-
uation. Above the Channel Information Area is the Setting Panel Area. If you don't
want see the Setting Panel Area, you can click the Hide Setting Panel check box to
hide the Setting Panel Area. If you want to see the raw data (presented in Hexadec-
imal format) from the input channels, click the Show Raw Data check box.

APAX-5080 supports several operating mode (Bi-direction, Up, Up/Down, Frequency,
and A/B phase). Select the channels you want to control the output value in the
Channel Information Area (use the "Shift" or "Ctrl" key on keyboard to select multi-
ple channels at the same time). Then you can configure the selected counter input
channels' mode by the CNT Mode combo box. You also can define the initial value
when module is power-on, by entering the value you want to the Startup value
(0~4294967295) text box. Click the Apply button when you complete the counter
mode or startup value setting. If you want to save the setting for all channels, click the
ApplyAll check box before you click the Apply button.

Click the Start button in the Set channels Area to start counting action for the
selected counter input channel. Click the Stop button in the Set channels Area to
stop the counting action for the selected counter input channel. You can reset the
selected counter input channel by clicking the Reset Cnt button in the Set channels
Area. Counter value will become the startup value (defined by the Startup value
(0~4294967295) text box) if you click the ReloadToStartup check box. Otherwise,
the counter value should back to zero after you click the Reset Cnt button. 

Note! Refer to APAX-5000 I/O Manual to see definition of different counter 
modes. 
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When you click the Repeat check box in the Count Type Area, it means when the
counter value reaches the maximum or minimum acceptable counting value, it will
restart to count (starting from 0 or the startup value, depending on the ReloadToStar-
tup check box.) Otherwise, the counter value won't change its value after reaching
the maximum or minimum acceptable counting value. Click the Apply button when
you complete the repeating and reload to startup setting. If you want to save the set-
ting for all channels, click the ApplyAll check box before you click the Apply button.
APAX counter module supports counter gate function. It means the counter action
(counting or not) will be performed depending on signal value from specific digital
input channel. Related configuration is done by the parameter in the Counter Gate
Setting Area. Select the channels you want to configure in the Channel Information
Area (use the "Shift" or "Ctrl" key on keyboard to select multiple channels at the same
time). Then configure the parameters listed below for the counter gate function:
1. Enable check box: Enable or disable the counter gate function.
2. Mapping gate combo box: It defines which DI channel's is used (as the gate 

channel) for this counter channel.
3. Gate Active Type combo box: What condition when the DI channel's status 

match will let the counter channel perform the counting action. 
"Low level": The specific counter channel will perform counting action only when 
the gate channel (specific DI channel) value is logic low.
"Falling edge": The specific counter channel will perform counting action only 
when a falling edge (the DI channel changes from logic high to logic low) is 
detected. 
"High level": The specific counter channel will perform counting action only 
when the gate channel (specific DI channel) value is logic high.
"Rising edge": The specific counter channel will perform counting action only 
when a rising edge (the DI channel changes from logic low to logic high) is 
detected. 

4. Trigger Mode combo box: It defines if the gate can repeatedly trigger the 
counter channel performing counting action. Refer to figure below.
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B.1 EtherNet/IP Address Mapping Table (0x)
Type: ETHERNET-MODULE Generic Ethernet Module
Common Format: INT
Assembly Instance:

Input: 102
Size = 12 x [ APAX-5000 analog I/O module number] + 4 x [ APAX-5000 digital I/
O module number] + 26 x [ APAX-5000 counter module number]
Output: 101
Size = 12 x [ APAX-5000 analog I/O module number] + 4 x [ APAX-5000 digital I/
O module number] + 26 x [ APAX-5000 counter module number]
Configuration: 103
Size = 0

Mapping Rule

Offset Input Output
0 ~ x1 Data from APAX module with ID 0 Data from APAX module with ID 0
x1 ~ x2 Data from APAX module with ID 1 Data from APAX module with ID 1
x2 ~ x3 Data from APAX module with ID 2 Data from APAX module with ID 2
x4 ~ x5 Data from APAX module with ID 3 Data from APAX module with ID 3
... ... ...
x31 ~ x32 Data from APAX module with ID 32 Data from APAX module with ID 32

Warning! The ID number for all APAX modules should be sequentially and start 
from 0, or the data will not be read.
APAX-5072 Software Manual 44



A
ppendix B

E
thernet/IP

A
ddress

M
apping Table
Analog Input and Analog Output Modules 
Each APAX analog module will use 24 BYTE (12 WORD, or 12 INT) address for its
data. Each analog channel will occupy one WORD address. 

Digital Input and Digital Output Modules 
Each APAX digital module will use 8 BYTE (4 WORD, or 4 INT) address for its data.
Each WORD address will contain 16 digital channel data. 

Counter Module 
Each APAX counter module will use 52 BYTE (26 WORD, or 26 INT) address for its
data. The first 4 WORD address will reserved for digital input and digital output chan-
nels. Then 16 WORD address will be used for counter channels' value. The rest
address will be left for other counter setting, such as counter mask, reset, overflow
and underflow, etc. 

Data Input Output Description
Word 0 DeviceName:I.data[0] DeviceName:O.data[0] Analog Channel 0 Value
Word 1 DeviceName:I.data[1] DeviceName:O.data[1] Analog Channel 1 Value
Word 2 DeviceName:I.data[2] DeviceName:O.data[2] Analog Channel 2 Value
Word 3 DeviceName:I.data[3] DeviceName:O.data[3] Analog Channel 3 Value
... ... ... ...
Word 11 DeviceName:I.data[11] DeviceName:O.data[11] Analog Channel 11 Value

Data Input Output Description
Word 0 DeviceName:I.data[0] DeviceName:O.data[0] Digital Channel 0 ~ 15 Value
Word 1 DeviceName:I.data[1] DeviceName:O.data[1] Digital Channel 16 ~ 31 Value
Word 2 DeviceName:I.data[2] DeviceName:O.data[2] Digital Channel 32 ~ 47 Value
Word 3 DeviceName:I.data[3] DeviceName:O.data[3] Digital Channel 48 ~ 63 Value

Data Input Output Description
Word 0 DeviceName:I.data[0] DeviceName:O.data[0] Digital Channel 0 ~ 15 Value
Word 1 DeviceName:I.data[1] DeviceName:O.data[1] Digital Channel 16 ~ 31 Value
Word 2 DeviceName:I.data[2] DeviceName:O.data[2] Digital Channel 32 ~ 47 Value
Word 3 DeviceName:I.data[3] DeviceName:O.data[3] Digital Channel 48 ~ 63 Value
Word 4 DeviceName:I.data[4] DeviceName:O.data[4] Counter Channel 0 Value (High)
Word 5 DeviceName:I.data[5] DeviceName:O.data[5] Counter Channel 0 Value (Low)
Word 6 DeviceName:I.data[6] DeviceName:O.data[6] Counter Channel 1 Value (High)
Word 7 DeviceName:I.data[7] DeviceName:O.data[7] Counter Channel 1 Value (Low)
... ... ... ...
Word 18 DeviceName:I.data[18] DeviceName:O.data[18] Counter Channel 8 Value (High)
Word 19 DeviceName:I.data[19] DeviceName:O.data[19] Counter Channel 8 Value (Low)
Word 20 DeviceName:I.data[20] DeviceName:O.data[20] Start/Stop Flag for 8 Counter 

Channel
Word 21 DeviceName:I.data[21] DeviceName:O.data[21] Reset Flag for 8 Counter 

Channel Value
Word 22 DeviceName:I.data[22] DeviceName:O.data[22] Overflow/Underflow Flag Status 

for 8 Counter Channel
Word 23 DeviceName:I.data[23] DeviceName:O.data[23] Clear Overflow/Underflow Flag 

for 8 Counter Channel
Word 24 DeviceName:I.data[24] DeviceName:O.data[24] Alarm Status on the Counter 

Module 
Word 25 DeviceName:I.data[25] DeviceName:O.data[25] Clear Alarm on the Counter 

Module 
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Example: We have four APAX-5000 modules connected with APAX-5072: APAX-
5017 (AI), APAX-5028 (AO), APAX-5040 (DI) and APAX-5046 (DO). So the Assem-
bly Interface will be listed as below:

Input: 102                 Size: 12 x 2 + 4 x 2 = 32
Output: 101              Size: 12 x 2 + 4 x 2 = 32
Configuration: 103   Size: 0

If the ID switch on the four APAX modules are set as: 
APAX-5017 ID = 2
APAX-5028 ID = 1
APAX-5040 ID = 0
APAX-5046 ID = 3

Note! You need to change the flag value from low to high and then set it back 
to low to perform resetting counter channel value function. It is the same 
to perform clearing counter channels' overflow/underflow status and to 
clear counter module's alarm status. 

Note! As we mentioned before, the ID of all APAX modules should be sequen-
tial and start with 0. So if we change the APAX-5040 ID to 5, then all 
APAX I/O module data cannot be read back to the Ethernet/IP master.

Data Input Output Description
Word 0 DeviceName:I.data[0] DeviceName:O.data[0] APAX-5040 channel 0 ~ 15
Word 1 DeviceName:I.data[1] DeviceName:O.data[1] APAX-5040 channel 16 ~ 31
Word 2 DeviceName:I.data[2] DeviceName:O.data[2] APAX-5040 channel 32 ~ 47
Word 3 DeviceName:I.data[3] DeviceName:O.data[3] APAX-5040 channel 48 ~ 63
Word 4 DeviceName:I.data[4] DeviceName:O.data[4] APAX-5028 channel 0 value
Word 5 DeviceName:I.data[5] DeviceName:O.data[5] APAX-5028 channel 1 value
Word 6 DeviceName:I.data[6] DeviceName:O.data[6] APAX-5028 channel 2 value
... ... ... ...
Word 14 DeviceName:I.data[14] DeviceName:O.data[14] APAX-5028 channel 10 value
Word 15 DeviceName:I.data[15] DeviceName:O.data[15] APAX-5028 channel 11 value
Word 16 DeviceName:I.data[16] DeviceName:O.data[16] APAX-5017 channel 0 value
Word 17 DeviceName:I.data[17] DeviceName:O.data[17] APAX-5017 channel 1 value
Word 18 DeviceName:I.data[18] DeviceName:O.data[18] APAX-5017 channel 2 value
... ... ... ...
Word 26 DeviceName:I.data[26] DeviceName:O.data[26] APAX-5017 channel 10 value
Word 27 DeviceName:I.data[27] DeviceName:O.data[27] APAX-5017 channel 11 value
Word 28 DeviceName:I.data[28] DeviceName:O.data[28] APAX-5046 channel 0 ~ 15
Word 29 DeviceName:I.data[29] DeviceName:O.data[29] APAX-5046 channel 16 ~ 31
Word 30 DeviceName:I.data[30] DeviceName:O.data[30] APAX-5046 channel 32 ~ 47 
Word 31 DeviceName:I.data[31] DeviceName:O.data[31] APAX-5046 channel 48 ~ 63

Note! APAX-5040 only has 24 channels (channel 0 to channel 23). So 
although the Ethernet/IP package will carry 64 channels' data, address 
for channel 24 to channel 63 won't be used (It would be empty). It is sim-
ilar for the APAX-5046. 
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